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Abstract 

This guide provides users of DTS File Security Manager (FSM) an understanding of how to use 
the product including insight into getting around in the User Interface. After reading the 
information within this document the user will understand how to use FSM to improve the state of 
their storage infrastructure. 

 

Rev 2.2, August 2011



DTS File Security Manager User Guide  

Copyright © 2011 by Derry Technological Services, Inc. All rights reserved. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The information contained in this document is believed to be accurate as of the date of 

publication. Because DTS must constantly respond to changing market conditions, what is 

here should not be interpreted as a commitment on the part of DTS, and DTS cannot 

guarantee the accuracy of any information presented after the date of publication. 

This document is for informational purposes only. DTS MAKES NO WARRANTIES, 

EXPRESS OR IMPLIED, IN THIS DOCUMENT. 

All product and company names mentioned herein may be the trademarks of their 

respective owners. 

DTS, 31 Emerald Drive, Derry, NH 03038, USA 
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Introduction 

DTS File Security Manager (FSM) is a valuable component of an overall storage resource 
management (SRM) architecture and helps organizations close critical security loopholes that 
often go unaddressed while also enhancing the performance and functionality of many critical 
storage management products including those that handle quota management, storage reporting 
and storage chargeback. 

This document is a guide to the successful utilization of DTS FSM. 

Before You Begin 

FSM is designed to be used by administrators to carry out administrative tasks that have a 
positive impact on system security.  The application will not be able to change the ownership and 
permissions of files and directories if the user running the program does not have administrative 
privileges on the storage being managed.  

 

Purpose 

DTS FSM is designed to resolve the problems that arise from file and directory ownership and 
permissions not being maintained.  While Windows has always allowed Administrators to take 
ownership of files and directories and in recent versions has allowed Administrators to assign 
ownership, the interface to make these changes is not practical when confronted with a multiple 
terabyte system. The same issues that make ownership onerous to manage are amplified by the 
additional layers of complexity when setting permissions on unstructured data. By providing a rule 
based system that can run though a massive amount of data and applies rules, DTS FSM makes 
maintaining file and directory permissions and ownership on even the largest storage systems 
easy.   

 

Editions Available 

DTS FSM is available in five editions from Basic Edition to three storage platform specific 
Enterprise Editions. 

·  Basic Edition  – Provides utility functionality for organizations that just want to target a 
small number of specific files and directories and set ownership and permissions 
manually.  This edition does not include the advanced Rule and Rule Set functionality 
available in the other editions.  The Manual Mode described in this document defines the 
complete functionality of the Basic Edition. 

·  Professional Edition – Provides all of FSM’s functionality for local drives on the system 
where the software is installed.  This edition does not support remote drives or UNC 
paths and does not support Home Directory rules which require integration with Active 
Directory. 

·  Enterprise Edition – Provides the ability to create Rule Sets that run against local 
drives, mapped drives and UNC paths.  The Enterprise Edition also provides for Rules 
that specifically integrate with Active Directory to fix permissions and ownership based on 
Home Directories also known as Home Directory rules. 
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For all editions licensing is by server.  In the case of the Basic and Professional Editions you must 
install the software on all computers where you desire the functionality.  The Enterprise Edition 
allows for centralized administration with licenses priced based on platform including SAN and 
NAS licenses in addition to Standard Windows Server licenses. 

Getting started 

After installing FSM and activating the license (see a later section of this document or the DTS 
FSM Installation Guide for details) open up FSM and you will be shown the main interface for the 
program (shown below).  When first installed there are no Rule Sets defined. 

 

 

Creating Test Rule Sets 

By default the program does not have any Rule Sets defined, but to help you get up and running 
quickly the product provides you with the ability to create test Rule Sets under the File menu.  
The Create Test Rule Sets option (shown below) opens a dialog that gives you options for the 
Rule Sets that are created for your testing. 
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The purpose of the Create Test Rule Sets functionality is to create a test directory structure (it 
defaults to the Test directory under the FSM install directory, but is configurable) and pairs of 
Rule Sets that allow you to change the ownership of the Test directory structure back and forth 
between the Administrator and the current logged in user by running the Rule Sets (configurable 
via the dialog shown below) and/or change the permissions of the Test directory structure by 
granting the current logged in user Full Control permissions and removing that permission by 
running the Rule Sets.  The resulting dialog allows you to quickly specify the parameters for the 
Test Rule Sets that will be created including whether they use business names for the file 
structure or just test directory names (Realistic Names vs. Utilitarian Names option). 

 

After you have clicked on the Create button with the default settings you end up with one or more 
pairs of Rule Sets defined as shown below. 
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Using Manual Mode 

Even before you create your first Rule Sets you can use the Manual button to quickly and easily 
set file and directory permissions and ownership.  The Manual Mode functionality is the quickest 
way to set the security on a small number of files and/or directories.  You can reach the Manual 
Mode interface through the Run menu by selecting Manual Mode or by clicking on the Manual 
button on the main interface.  The Manual Mode screen contains all the functionality available in 
the DTS FSM Basic Edition and is shown here (see below). 

 

The example of using Manual Mode pictured above shows files in the selected directory owned 
by the BUILTIN\Administrator.  The current logged in user is Phynds from the DTS domain and 
that user becomes the default for the New Owner to Assign  when the screen loads (but can be 
changed manually or by clicking on the Select User  button).  Clicking on the Assign Owner  
button next to the selected file will reassign ownership of that file to DTS\Phynds.  On the far right 
of the screen you see the permissions controls which allow the permissions to be quickly and 
easily set for the selected file or directory. 

 

Anatomy of a Rule Set 

The Rule Set defines what needs to be changed and where on the storage system.  Rule Set 
definitions consist of the Rule Set name, the rules that make up the Rule Set and the drives 
and/or paths that the Rule Set is applied against.  The interface for creating and editing a Rule 
Set is shown below with both the Summary  (where rules are listed) and Select Where Rules 
Apply  (where the rule applies on disk) tabs displayed. 
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The Rules can be configured with ultimate flexibility.  In the screenshot below you see that you 
can add criteria to have a rule only effect files or directories (also configurable) owned by a 
specific user or based on the file size, file age or file extension as well as the name pattern of files 
or directories.  The Configure Rule Settings screen shown below is quite easy to use provided 
you know what you wish to accomplish. 
 

 
 
 

Running a Rule Set 

Once you have your Rule Set defined as desired you can run it from the main screen by selecting 
it and clicking on the Run button.  By default the Run Rule Set screen will be configured to run the 
Rule Set in Test Mode.  In Test Mode, no changes are made on the file system, but the output 
shows you exactly what will happen when you run in Live Mode.  As the Rule Set runs the 
statistics section shows details about the progress including the number of errors encountered, 
files modified, directories modified and total number of files and directories processed.  Below are 
screenshots that show of what the output looks like after a Rule Set has been run (in this case 
one of the Test or Demo Rule Sets).  The first screen below shows the output screen scrolled all 
the way to the top and the second with the output screen scrolled to the bottom. 
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Languages Supported 

DTS FSM currently supports English, German, Spanish and French.  By default the program will 
use the locale setting defined on the system on which FSM is installed, but if you would like to 
change the system to use another language independent of the locale setting the Language 
menu allows you to override with whatever language you prefer (of those supported of course).  
In the screen below you can see what the main screen looks like when German is choose under 
the Language (Sprachen after the change). 
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Configuration Options 

Database Configuration 

DTS FSM uses a backend database to store application settings including the Rules and Rule 
Sets.  The system supports Microsoft Access and installs and uses an Access MDB named 
FSM.mdb by default.  The system also supports Microsoft SQL Server if desired (contact DTS for 
instructions to create the Microsoft SQL Server version of the FSM backend database).  The 
Database Configuration screen (shown below) is accessible via the Configuration menu on the 
main screen. 
 

 
 

License Allocation (Enterprise Edition Only) 

If you have installed the Enterprise Edition of DTS FSM then the License Allocation screen is 
available under the Help menu.  The Basic and Professional Editions only work against the local 
fixed drives of the system with DTS FSM installed and therefore only come with a single license 
per system.  The License Allocation screen allows the user to specify which systems are licensed 
and therefore allowed to have their shares mapped via Mapped Drives and UNC paths.  The local 
system always consumes as a license (Standard or SAN). 
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Drives and UNC Paths (Enterprise Edition Only) 

If you have installed the Enterprise Edition of DTS FSM then the Drives and UNC Paths 
configuration screen is available under the Configuration menu.  The Basic and Professional 
Editions only work against the local fixed drives of the system with DTS FSM installed.  The 
Drives and UNC Paths configuration screen allows the user to specify which drives (local and 
mapped) and UNC paths should be selectable when defining your Rule Sets.  After you allocate 
licenses to systems you can select where users will be allowed to run their Rule Sets from the 
servers which are licensed. The local system always consumes a license and at least one local 
drive must be selected. 
 

 
 
When new UNC Paths are added to the screen they are verified to ensure they are available and 
online. 
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Logging 

DTS FSM supports three levels of logging of information when running a Rule Set including 
Summary Logging  (default level), User Friendly Output  and Machine Output .  By default the 
log files are written to the installation directory. 
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Performance Settings 

Some organizations have to be careful about the impact that management tools have on the 
users actually trying to get work done using the storage systems under management.  For that 
reason, DTS FSM provides a performance throttle which inserts a delay between operations to 
help keep down CPU spikes.  Use the Performance Configuration screen to set a scan delay 
value (defaults to zero).  If you leave the Scan Delay setting at zero the system will not introduce 
any delay when applying Rule Sets as they run. 
 
The Real Time Output option is very useful when scanning very large systems with millions of 
files as the default output settings will sometimes prevent FSM from working as fast as possible 
and can cause the program to consume a good deal of system memory.  The Real Time Output 
setting along with the Logging Level setting allows you to minimize the output while the Rule Set 
runs to get the best performance. 
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Active Directory Configuration 

DTS FSM supports integrating with Active Directory for the purposes of running what are referred 
to as Home Directory Rules.  The interface to test that integration allows customization of the 
Active Directory Connection String and subsequent testing. 
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Activating the Software via the License File 

By default, when DTS FSM is installed, the application is not activated and therefore the 
functionality that actually makes changes to permissions and ownership are disabled. The 
process of activating the software is straight forward and in most cases must only be done once 
per installation. 

 

Activation via the Web 

DTS FSM allows some customers to retrieve their license file automatically via the Get License 
menu item under the Help menu in cases where Internet access is available 

 

License Allocation (Enterprise Edition Only) 

The License file information includes the number of licenses and types of systems licensed.  For 
example if you purchase the Enterprise Edition with 3 Enterprise licenses, 4 Enterprise SAN 
licenses and 3 Enterprise NAS licenses you can install the software on the server of your choice 
and then configure which system the licenses apply towards via the Drives and UNC Paths 
Configuration screen. 

 

Activation via License File 

These steps assume you have been sent either a copy of your license file or you have 
downloaded it via a web link.  Copy the license file into the same directory where you installed 
FSM (i.e. look for the exe and put the file in that same directory).  Once you have that file place, 
unaltered you can use the following steps to activate your copy of FSM. 

1. Open FSM and drop down the Help  menu and Select About . 
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2. As you can see the program recognizes the license file (licYIEdipzSk1.dat in our 
example), but it has not been enabled yet. Click on the Activate  button 

 

 
 

3. Enter the email address and password associated with the product.  These 
should have been provided to you along with the license file. Click Activate .  
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4. Once the activation is successful (provided you entered the correct email address and 
password for the license) the About box will be display the license information as show in 
the example below. 

 

 
 

5. Ensure that the resulting screen shows the proper Edition, Version and Expiration date (if 
any) as expected. 
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For Additional Information 

Please refer to the DTS File Security Manager (FSM) Installation Guide, for more details on 
installing the application in preparation for using the information given in this guide. 
 

About DTS 

DTS takes pride in our technical expertise in the area of security. We create products that enable 
companies to automatically control access of their users’ stored files. 

 

DTS Professional Services 

For further assistance with DTS, contact your DTS representative at 603-845-3611. 

DTS offers end-to-end consulting and training services to assist in the deployment and 
configuration of your storage management solution. Our Professional Services staff includes 
certified instructors for Microsoft and DTS systems as well as other technologies. 

DTS 
31 Emerald Drive 

Derry, NH 03063-4066 
Call: 1-603-845-3611 

Website: www.dtsnh.com 
Email: sales@dtsnh.com 


